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This handout contains screen shots of confidential and proprietary information
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purpose as a training device for the County of San Diego, Mental Health
management Information System.
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CONFIDENTIALITY

HIPAA regulations mandate that all client information be treated confidentially.

Access to CCBH is based on your position and your job classification. You will have the
access you need to complete your job duties. This can include access to clients in your
Unit/SubUnit or may include full client look up. Remember — with more access comes
greater responsibility regarding confidentiality!

You are not to share passwords with other staff. The Summary of Policy you signed
before receiving your access to CCBH included your agreement to this directive. You
are still responsible if someone with whom you have shared your password violates
confidentiality!

The MIS unit investigates any suspicions regarding sharing of passwords.
Consequences are up to, and may include termination.

Do not open any active client charts unless instructed to do so, or if it is required to
complete your job duties. “Surfing” clients is a blatant breach of confidentiality.

Remember you are personally and legally responsible for maintaining confidentiality.
Take it seriously.

Do not leave your computer unlocked with client data on the screen for others to access
or view while you are away from your desk. Lock your CCBH session before leaving
your computer.

When printing, make sure you are printing to a confidential printer, and pick up your

paperwork quickly. Leaving printed Protected Health Information (PHI) out is also a
confidentiality violation.

Play it safe — keep in mind how you would want your own PHI handled!
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CCBH SOFTWARE BASICS

CCBH IS ACCESSED THROUGH CITRIX (Cerner):
Go to https://cosdca.cernerworks.com

(Save this to your favorites or create a shortcut for your desktop)
“TAB TO TRAVEL”: Get in the habit of usin?_ ){our “Tab” key. Using the “Tab”
ie

assures that you are directed to all required fields and that the information you
input is actually captured by the system.

ﬁl HT CLICK: When.there is no obvious way to add information into a field, right
click in the space to view your options.

\I/:vlrlférnEsReSe{r%ﬁRIgoth%légIa%’gssé _Check these first and make sure they are on “all

MAGNIFYING GLASS/ELLIPSES “BUTTONS”: When you see these at the end
of a field, it means there is a “Search Screen” that you can pull up to find
information for that field. You do not have to use them, but they are there if you
need them.

REQUIRED FIELDS are in red or blue: They must be filled-in to save and final
approve information.

OPTIONAL FIELDS are in white: Information may be added, but is not required
to final approve the Assessment. Keep in mind — just because you have
completed all the fields required to final approve the form, does not mean
you have completed a thorough clinical assessment. Documentation
standards have not changed.

CLOSED FIELDS are in gray: Nothing can be added in thesefields.
CASE SENSITIVE:

o Passwords — if you receive an error message for “Invalid Password”, check to
make sure you are using the appropriate upper and lower case letters when
typing. After a third attempt with an invalid password, the system will lock
your session and will require contacting the Optum Support Desk (1-800-834-
3792) to unlock it.

o Table Searches — when searching within a table, be aware that descriptions
or IDs are case sensitive. If you do not use the correct upper or upper and
lower case entry, the search will not take you to the desired table value.

MULTIPLE WAYS TO ACCESS INFORMATION: In CCBH, it is easy to access

the same information in multiple ways. We have included screenshots and
directions in this document to guide you through the system.
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o LOCKING YOUR SESSION: For security purposes, you must lock your session

any time you step away from your computer. This packet explains the various
ways to lock your session.

(UJ Note: Locking your session is best used for short times away from your computer.
CCBH will log you out after 60 minutes. There is a chance of losing work that has not
been final approved or saved if CCBH logs you off.

o WHEN YOU GO BACK TO YOUR PROGRAM: You are learning how to enter
assessments in the “SDC Train CCBH” environment during this training, which
is for practice purposes only. It is important to enter all of your assessment
information in the “SDC Live CCBH” environment when you return to your
program.

e For password resets/menu issues: Call the Optum Support Desk. You may also
call if you need your “SDC Live CCBH” environment password or menu set up.
Their contact information is:

m Desk
1-800-834-3792
Reminder:

Menu access is set according to job title/functions. The menus you have at your
program may look different than menus shown in the screen shots in this
packet.
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CCBH SPEAK

Assessment

In CCBH, anything that is not a Client Plan or a Progress Note is
considered an “Assessment.” So, in CCBH Speak, forms such as the
Discharge Summary, Outcome Forms, and Demographic Form are
considered “Assessments” as well as the actual clinical assessment
forms.

Clinician’s
Homepage

A “page” that provides the Clinical servers at each open assignment to
view client/s and client information for the identified caseload in one
screen. This includes client look up, caseload listing, appointments,
task/s to do, notifications, and other client information present in the
EHR.

Collateral
Server

Co-Staff providing a service (i.e. co-facilitator). Used when more than
one staff is providing a service to the same client, on the same date
and at the same time as server.

Demographic

A client is entered into the EHR by the completion and final approval of
the demographic form. A client may not be opened to
assignment/program unless the demographic form is entered,
completed, and final approved.

Final Approve

Locks the completed assessment.

assessments.

Prevents editing/deletion of

SAl - Single
Accountable
Individual

Primary server identified based on primary unit program set up. This
staff will be listed as the primary contact for the client in the system of
care for purposes of coordination of care.

Service Code

Procedure Code. The code data entered into the EHR for the purpose
of claiming a service activity.

Server Staff providing a service activity.
Unit The Physical Location of a program, or legal entity.
Sub-Unit The specialized set of services offered within a Unit (i.e. population,

funding sources, efc.).
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PASSWORD CHANGES

Citrix (Cerner) Password

The first Citrix (Cerner) password you ever receive is considered a temporary password.
For security reasons, you will be prompted to change your password on your first log in.
To do so after the initial login, click “Change Password” when first logging in to Citrix
(Cerner).

S= Cerner

Log Off

Change Password

User name: COSD_CA\anasazigen10

Odpaswort | ' Next, follow the prompts to change your
e st password.

Confirm password:

0K Cancel

CCBH Password

You are prompted by the system to change your CCBH password every 90 days.
However, if you feel that someone has learned your password, for security reasons you
should change it immediately. There are two ways to do this:

External View

File Scheduler Client Assign From the External View, go to the “Access” tab and
select the “Change Password” option. Follow the

Lock Session

prompts to change your password.

Change Password
Manage Security Questions
File . Home . View
Clinician’s Homepage @
E Perform Security Actions
From the Clinician’s Homepage, go to the b i:‘ﬂ E @
File Tab. Select the “Security” menu, and Menu .

|||_\_‘*:| Change Massword
-]

then select the “Change Password”

. L Security b

option. Follow the prompts to change |

your password. H oo €
| = |

REV 2/2023



Assessments

LOCK CCBH SESSION

For security reasons, the expectation is that you will lock your CCBH session any time
you step away from your computer. There are two ways to do this.

Clinician’'s Homepage

From the Clinician’s Homepage, go to the “File Tab” and select the “Security” drop down
menu, then select “Lock Session” button.

Home View =
Lock Session?
Eg Open Perform Security Actions _
=% Lock Anasazi session for STAFF CLINICAL?
— 0L Lock '-. )
A . ] e . .
b Menu WARNING: Any reports currently running that are output to screen will
I i"‘*l Change Pas display on the terminal when completed. User should lock the terminal
-ll Security - using Windows functionality.
1
|ﬂ About CCBH
Yes No
\g“ Preferences | | 34 Exit Application

External View

From the External View, go to the “Access” tab and select the “Lock Session” option.

File Scheduler  Client Assign

Q | Lock Session

CLIE Change Password
; Manage Security Questions

You will be prompted to enter your password to unlock the session.

gﬁﬂ This Anasazi Sezzion has been locked

This &nasazi Session is in use and has been locked.
Only the Staff member who locked this sezsion may unlock, it

Paszwaord: ||

] Cancel
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o Go to the “File Tab” menu in the top left-hand corner of your screen.
o Select the “Exit Application” option.

EXITING THE APPLICATION

Assessments

EXITING CCBH: To make sure you do not accidentally create a “ghost session”
and lock yourself out of accessing CCBH, you must exit in the following manner:

Clinician’s Homepage

Home View

Open
—_—

Menu

¥
!;—ll Secur|
il

ﬂ About CCBH o |
il Preferences Exit Application|
~

ity

External View

o Go to the “File” menu in the top left-hand corner of your screen.
o Select the “Exit” option.

o Repeat this step for any open external view window.

Clear/Add
Delete

Save
Prompt

Close Active View

Exit

Lo] coheduler (Staff: CLINICAL, STAFF)
Access  ClientData ATP  Scheduler

F5
Shift+F2
F2

F4

F3
Alt+F4

8 -

LI

You risk being locked out of CCBH if you do not exit in the manner described

above!
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CLINICIAN’S HOMEPAGE PREFERENCES

How to setup and save preferences

Accessing Preferences:

Open

Menu

=8l

A- From the “File Tab”
B- Select the “Preferences” icon

o Select the plus sign next to “New Assessments.”

Security

View

About CCEH

X Exit Application

Preferences for New Assessments:

o Click “Commonly Performed Assessments”

o Click “Add”

This feature allows you to set the Assessments that you use most frequently as
preferences for easy access.

Assessments

File 5:aff Preferences

HE B8 8 iz &

Save save and Add JRemove Fefresh Delete Close

Closs Selection | Panel
Seve Grid Acions Clase
Preferences Currently Viewing Information for Commonly Performed Assessments
- Aulo Reslone

+‘; Client Panes
amew Assessments
Y ommony Performed Assessments

Mew Progress MNotes
- New Client Plans
Pharmacies

[+ StaffPanes

Commonly Performed Assessments
[0 ] Drezcripton

10
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1) Select the assessment(s) you commonly perform. To select multiple
assessments, hold down the “control” key as you click with the mouse.
2) Once you have selected your preferred assessments, click the “Select” button.

Multiple Selections

% L

Refresh  All Invert Search

Actions

L

Select

[d

|
Close
Panel
Close

Available Assessments (Filters Applied) -
D |Type - | Active | o
Al AlMS -]
ASOCA ASO Clinical Addendumn =
BHACDS BHA 0-5 Children =
BHAC BHA Children =
BHACSU BHA Crisis Stabilization Unit =
BHADEC BHA Dev Eval Clinic . =
BHAESU BHA ESU AL [HON Soumine ]

control ey to select more =

BHATBS BHA TBS . =
_ S than one option =

CANS CONFI CANS Sharing Confirmation =
CFARS CFARS &=
CPCONP Client Plan Confirmation Page =
TFC Daily TFC Progress Mote 1]

raphics Form

SDIAGREC Diagnostic Reconciliation

A Discharge Summary

SDSMSRECOMN DSM- 5 Diagnaosis Reconciliation
EATDISADM Eating Disorder Admission

Assessment List Filters Available Assessments (Filters Applied)

You will see your selections.

I!|! Staff Preferences. |

HE GB

B is O

Save Save and Add Remove Refresh Delete Close
Close Selection Panel
Save Grid Actions Close
Preferences Currently Viewing Information for Commonly Performed 2
¢+ Auto Restore

- Client Panes
=] Mew Assessments

- New Progress Notes
- New Client Plans

i~ Pharmacies

[#- Staff Panes

mmonly Performed As:

Commonly Performed Assessments

[0 ]
BHAA
DCSUM
DEM
DI4G

11

Dezcription
Dizcharge Surnmary

Demographics Form
Diagnosiz Farm
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Saving Preferences:

Staff Prefererces

Save Save and Add Remove Refresh Delete
Close Selection

Save arid Actions
You have 3 options:

Save:
e Click the “Save” icon. This will save settings only.

Save and Close:

Close
Panel

Close

Assessments

¢ Click the “Save and Close” icon. This will save your selections and take you back

to the Clinician’s Homepage.

Close Panel:

e WARNING: If you click the “Close Panel” icon without saving, all of your

preferences will need to be reset.

@ Note: These preferences will not transfer from your TRAIN account to LIVE. They

must be setup in LIVE too.

12
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CLINICIAN’S HOMEPAGE TERMINOLOGY

Identifying Terms Used on the Clinician’s Homepage

Clinician’s Homepage:
The Clinician’s Homepage is a real-time tool that provides up-to-the-minute client status
at a glance.

File Tab:
It can be used to exit the application, set preferences, access the external view, or see
recently opened views.

F [ T

Tabs:
The “Tabs” listed below are displayed at the top of the Clinician’s Homepage.

e There are four tabs: “File”, “Home”, “Client”, and “View.”

m Home Client View

@ Note: The “Client” tab will only be available if a client has been selected.

Buttons:

e The “Buttons” are individual selections that can be clicked on to perform various

functions.
q H-:nme/ View / / / / / { !
5: 3 staff Clear '_:\ O‘j S Client Clear / [E services  fw System eRx not available @ IE;’EJ D:D
ty Home N - = show Client Panel B =
Staff Refresh Client Pharmacy @ Break The Layout and
Search Staff Panel = Search Directory Glass Filters =
Staff Entity Client Entity Group Notes ePrescribing Status Pharmacies Break Glass Panel Options

13
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Ribbon:

e The “Ribbon” is an object that is comprised of various buttons.

. Home WView

x - - 2 E[: % .
5 : §lq staff Clear laj Q;j <~ Client Clear [ serices  Jfa Systam eRx not available @ E__%] m
i My Home et = show Client Panel Fen ==
staff Refresh Client Pharmacy Break The Layoutand
Search : Staff Panel = Search -9%°° = 07 Directory Glass Filters ~
Staff Entity Client Entity Group Motes ePrescribing Status Pharmacies Break Glass Panel Options
Staff Panel:

The Staff Panel automatically launches when the Clinician’s Homepage is opened.

o B 8

Hi i Wi
E: Boseatr Crene =, Q—: T ot Cien -1j51n.._.” M Syvten eRx not svaitabie l%_’_i] m
1 i . e T S Shew Coent Pane T . |
waft Refresh Chient Pharmacy | Break The  Layout and
Search SEaft Pamel | Sesach Carecteay Ghasi Filiers =
ShaM Erkfty Lherd Enity resp Metes efreitnbng Shatus Marmacizi Broak ass Pant Opteend
.. STAFF CUNICAL - ®

You will see your name as well as your job title listed. If you believe that the job title is
incorrect, you must complete a new ARF form and submit it to the MH MIS Unit for
correction.

Caseload: ('-,
W STAFF CLINICAL
| R
Type EName £

The Staff Panel (jefaults to show your cas_eload. Lsa HEROIC, CLIENT
These are the clients who have been assigned cAl TEST SSN

to you. You can always return to your caseload
by selecting the Caseload pane at the bottom of
the screen:

Caseload |Scheduled Services  Shortouts
ogged on as CLIMICAL, STAFF |

14
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CLIENT SEARCH

Searching for a Client Who Is In Your Caseload:

e On the Clinician’s Homepage “Home” tab, under “Caseload”, double click on the
name of the client.

e This action opens up the “Client Panel” where you can find information about
your client.

{3 CLINICAL STAFF

Caseload

Type |Name -
AT CUENT. FAKE
Cascloau DEER. RANM
SAI FANL CELBE
Pns-ntake KITE. FLYHG

Searching a Client Who Is Not In Your Caseload:

o Select the “Client Search” button

Home View

g £ staff Clear [ 3 |5 lient Clear
| My Home | = Show Client Panel

Staff Refresh Client
Search Staff Panel Search

Staff Entity Client Entity

o The “Client Lookup” window will open

H Click on the search button to perform a search for client records based on the criteria in the top section.

Client Search o
Client Search Parameters
Caze # ljl Sart Marne | | Search
Last | Fist| | oos[ /¢ | Thiu | Detaut |
Blias Last | | First | | Seu|- -] 55N [ Clear |

Client Search Results

Mame First  Last Case# S... Eth... DOB SSM Prim Unit ID Prim Uni... Prim SubUn... Prim Subl,..  External ... SALID  SAIM...

There are no items ta show,

There are several different ways to search for a client from this window:
15
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o By “Sort Name”: Enter the client’s sort name in the LAST NAME, FIRST NAME
format, then select the “Search” button. (The “Sort Name” is the client’'s name as

formatted when first entered into the CCBH system):

K Click on the search button to perform a search for client records based on the criteria in the top section.

There are no items to show,

Client Search 3
Client Search Parameters -
Case # —Eq Sort Name | Seaich
Last | ' First | ooB|// Thua | 7/ || Defaut
Alias Last | | Fist | | sex[- - SSN[ o _ |
Client Search Results
Nare: First  Last Case# 5., Eth... DOB  SSN  Prim Unit ID Prim Uni... Prim SubUn... Prim SubU... External... SAIID  SAIN...

o If the Sort Name you’ve entered is in the system, it will be displayed in the “Client
Search Results” area, as in this screen shot which exemplifies a search done for

fictional client sort name, “PIE, APPLE”:

H Click on the search button to perform a search for dient records based on the criteria in the top section.

Client search "
Client Search ers

cwet| | [ sortane [P aeLe | semeh |

Last| | First DDE| A | Thiu | Default |

| | | w ] s e
Client Search Results
Name First | Last Case# 5., Eth... DOB SSM | Prim Unit ID Prim Uni... | Prim SubUn... Prim Subl... |External ... SAIID |SAIN...
PIE, AFFLE  APPLE PIE F a a

Note: Double Clicking on the client's
@ name will launch the Client Panel.

o Ifthe Sort Name you entered is not in the system, you will receive the following

stop message:

@ Mo Clients were found using the current search criteria

o This does not mean that the client is not in CCBH. Rather, you may not have
entered the sort name exactly as it was formatted when the client’s information
was first entered into the CCBH system. For this reason, you should search by

other criteria such as:

16
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@ Note: Before beginning another type of search, select the “Clear” button to
reset the search criteria. Clear

In client search, enter LAST NAME, FIRST NAME, date of birth (check spelling
and in ALL CAPS).
o If clientis found with that name, double check SSN.
Search by SSN.
Search by Alias.
o If match found, open the Demographic form on client and double check
DOB, address, SSN.
o Check 3rd Party information to see if client has the same Medi-Cal (BIC,
CIN) number.
If it is unclear which is the first name or the last name, enter the other position of
names in Alias — e.g., Bubble Gum entered into CCl as GUM, BUBBLE may be
entered into Alias as BUBBLE, GUM.

@ Note: When searching use all capital letters, these fields are case sensitive.

o You can now search by one or more of the other criteria fields (Last, First, DOB,
Alias Last, First, Sex, Case Number). Select the “Search” button.

Kl Click on the search button to perform a search for client records based on the criteria in the top section.

1

Client Search 2 |
Client Search Parameters ‘
Case ft | il Sort Name Search |
Last | First | oo | // | Thu| 7 7 s |

Alias Last | First | Sex |- - SSN | ——— | Clear ‘

@ Note: If you search by data that is common in the system (such as conducting
a search only by a common first name) you will receive the following warning
screen. This allows you the option to either continue with or cancel the search.

“\_’/ The scanning of a large number of Client records has been detected and could lack up the syskem For a substantial amount of time, Would vou like to continue?

Yes | Mo

17
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Additional Client S h Feaf

o The “Thru” field, in conjunction with the “DOB” field allows you to search for
clients within a particular date range. For example, if the DOB is approximately
3/10/1964 and you enter 3/08/1964 in the “DOB” field and 3/12/1964 in the “Thru”
field, all clients in the system who have that dates of birth in that date range will
be displayed in the “Client Search Results” window.

@ Note: If the exact DOB is known ~ enter it in the ‘DOB’ and ‘Thru’ fields to find clients born only on that date.

K Cclick on the search button to perform a search for client records based on the criteria in the top section.

Client Search 2 |
Client Search Parameters |
Case ui Sort Name _ Search :
Last [ First [ poB[ /7 Thu[ 77 | Defaut
Alias Last | First 7 Sex |- v | SEN—s . T,
NOTES
18
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RESTORE SYSTEM DEFAULTS

If the layout becomes distorted, or the panes have disappeared, select “Restore Panel
Layout” (under the Layout and Filters button on the Home tab). This will restore the
layout to what it was when you first logged in.

Select “Restore Panel Filters” (under the Layout and Filters button on the Home tab) to
bring all the Filters back to their default settings, if desired.

CLINICIAN'S HOMEPAGE

e
I Home I WView

d ) ] S staff Clear I _J\ O:' A[Zi Client Clear ﬂr Services  faw System eRx not available @ iEf_T
ty Home N % myshowclientPanel | i en == m

Staff Refresh Client Pharmacy Break The Jlayout and
Search Staff Panel = Search Directory Glass Filters =

Staff Entity

Client Entity Group Motes ePrescribing Status Pharmacies Break Glass

. | ﬂ:lgl Restore Parm®l Layout

El STAFF CLINICAL
Caseload | |: }E‘l Restore Panel Filters |

NOTES

19
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ADDING NEW ASSESSMENTS

e Access the desired client.

¢ A“Client” tab will open with additional buttons listed within the ribbon.

e The Client Panel will launch on the bottom portion of your screen. The name of
the client will display in the client name box.

@ Note: A client name must be displayed in the “Client Panel” to have the “Client” tab
accessible.

CLENECIAN'S HOMEPAGE (TESTE) 2.000.0

3 - B (of Maapedee Massing Tiees CT 4 “ il -
i r = J £

n B L = & —— | +] L E &

T Broadcast  Mew Progiess g Fisw Cliend Mew Pre.eisting Prammacy  Mew Medical Refregh  Oose Client

I grmahign - alerl ol = Adipkiment = Pan - Rirdicaban of Chosr Condltion Bewiew  {hebed Paned Panal

S cimalion B Al Filenl Panl Optase

-
LN

s STAFF CLIMICAL
Larboad

Cirisioad - Scheduied Senvces  Shoftouls

< TEST FAKE

New Assessment Button:
e The New Assessment button will be displayed in the “Client” tab ribbon.

m Home I Clientl View

2 =] e = e ] o] ~ e =
Aﬂ = i u;’-f! £af Prospective Planning Tiers J:j-,‘ _— J'E N %]
Client Broadcast Mew Progres Mew ew Client Mew Pre-existing Pharmacy MNew Medical Refresh  Close Client
Information = Alert Note = Assessment -] Plan~ Medication of Choice Conditions Review  Client Panel Fanel
Note: The new assessment button is segmented in two parts. The upper portion
d]:] of the button is a list of all assessments available for entry. The lower portion

consists of assessments that have been established as “New Assessments” in
your “Preferences’.

To see a complete list of assessments:

e Click on the top portion of the “New Assessments” button.
e The “New Assessment Lookup” window displays.

20
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Lookup Panel e Search for the desired

“i E"l assessment by using the scroll

= A bar on the right side of the list.
jged | TR e Highlight the assessment you
Actions | Close wish to launch.

e Click “Select”.
e The system will open the
external view and the selected

B Select an Assessment Type from the list.

Assessment List (Filters Applied) .
assessment to begin data entry.
D [Type]

EHAC B Ha Children

Ol 1ACSL D1 1A Crisis Stablll.chtu:\n Llnmit NOte DOUb/e C/ICklng on the

BHADELC BH& Diew E val Cliric .

EHAESL EHA ESLI assessment will also launch the

BHATES BHA TES desired assessment.

CaMs COMFI  CAMS Shanng Confirnation

CFARS CFARS

CPCOMF Client Flan Confirmation Page

TFC Craily TFC Progress Moke

I DEM Demographics Form

Acsescment List Filkers | Assessment List (Filters Applied)

Dating the Assessment: F
Assessment

e Place the desired date in L@] H _—;Af @;J 2 EE

the date field. Refresh = Save | Request | Prospective Progress | Close
« Asszssment | Planning Tiers Indicztors  Pane
° Refer tO the GUIDELINES Refresh | Acticns Clinical Close

FOR DATES IN CCBH".

H Ciick Save to confirm selections and add a new Assessment

e Press the “Save” button.
This will launch the
assessment for data entry.

Aezezzment Type | EHA adult BHad,

@ Note: Correct entry of the date is essential. Once the date is entered in the
above field, it cannot be altered.

21
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GUIDELINES FOR DATES IN CCBH

Assessment Date:

When adding an assessment, the system will require the entry of a date when opening
the form for data entry. This is called the assessment date.

Adding Assessment for TEST FAKE | ®

Lssessm-‘:nt_
e : i = =
S HE & & B

Refresh Save Request Prospective Progress Close
Assessment | Planning Tiers Indicators Panel|
Refresh | Acions Clinical Close

Bl Click Save to confirm selections and add a new Assessment

Assessment Tune | BHA Adul EHAA,

The assessment date determines the date the assessment is sorted in the look up
window. The assessment date must match the service date that is claimed in the
system. Progress note documentation will need to support the service claimed. When
an assessment service takes more than one session to complete, multiple service dates
claimed must be indicated in each progress note for each service date. However, the
assessment date entered in the MIS will remain the initial assessment service date.
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Assessments

Signature Date:

Signature dates may be different than the assessment date, which is necessary at times
(i.e. when a co-signature is necessary but the staff is out of the office).

T, 1 ¥ :-'.1:'.' '.' :."'.'r'--.ﬂ.' or I."'J!".":I Pl
) l- i ; =1 & i‘ 5 date The system will son
Rsfresh i . the assessments i the
Blas Iookup by thus date
il
BHA Aduslll w 1 Sgnatires | = @
BHA Adult B FiaSg EntyT., | Sgnature Lne Headng Harma Date Time
3 Stalf Staf Regurre Co-Sgrabue TRAINEE CUIMICAL  03/320L5 02S5FM
Sl Staff CompyBooept Assessment  CREDENTIALED STAFF 03/30/2016 OREEFM

Cinty ool San Diegs Mental Health Senvices
BEAVIDRAL HEALTH ASSESSHENT - ADULT

@ Note: Co-signatures must be completed within timelines.
Final Approve Date:
The final approval date may be different than the assessment date and/or signature

dates. The final approval date is the date that the assessment is considered active and
complete. This date will also drive the timelines for documentation reviews.

|| ™ame: FAKE, TEST Casel Page: 10f3
Type: Demograrhics Form Date:  10/01/2014
Printed an 10M772014 2t 03:23 PM | (Final Approved on 10M 772014 at 03:22 Ph)

COUNTY OF SAN DIEGO MENTAL HEALTH SERVICES
DEMOGRAPHIC FORM
Admisslon Status O Pre-registered O Registered @ Admit

CLIENT IDENTIFYING INFORMATION
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Assessments

ELECTRONIC SIGNATURE GUIDELINES

e Certain assessments in CCBH can be final approved by any clinical staff who
have required system access, such as the Safety Alert or the Demographic
Form. Anyone can complete the assessment and final approve as themselves,
without a co-signature.

e Tofinal approve the Safety Alerts and Demographic Form

1) Make sure all software required fields have been addressed.

Validations «
Severity |'I.-'ali|:|aﬁ|:|n - Description
Critical  Empty Reguired Fields Al required fields must be completed to be Final Approved.

(a) To check, click the

“Perform Validation ﬂ H H \Jrq

Check” button at the Perform Save and Save Final
) Validation Check Close Approve
top of the window. A Validation Actions

screen will appear at

the center of your screen with a list of fields to be
addressed, if any. If all required fields have been
addressed, you will not see a screen appear. When
ready, proceed with the final approval step for the

assessment.
2) Click the e E——
“Fi | Pending Diagnosis Form for
A Ina ” m Assessment e
pprove P~ , = ™ h = =

[ ! - = i b P ™ .

button = o b H b |&D x [P @ EE;'
Refresh Perform Save and Save Final Print Delete Add Prospective Progress Close

Iocated at Validation Check = Close Approve Signature ¥ | Planning Tiers Indicators~  Panel
Refresh Validation Actions Delete Signatures Clinical Close

the top of

the window.

ch; Password - STAFF ADMIN x

3) Enteryour CCBH
password when I Passwardllt******** Ok
prompted.
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Assessments

e Some assessments contain validations - 0
credentlal restricted signatures. Se... |validston ~ | Description
For Instf'ance, th_ere ar? three Crit... Pending 5taff Sig... Must be electronically signed by at least
credential restricted signature one Staff Member to be Final Approved.
lines located in the “Validations” Crit... Staff Signature R... Seguence 1: Staff Reguiring Co-Signature
pane Of the Diagnosis Form, and Crit... Staff Signature R... Seguence 2: Staff Comp/Accept Assess. ..

Crit... Staff Signature ... Sequence 3: Staff Entering Information

two signature lines on the BHAs.

Signatures | Validations
e Your license type or credential will

determine how you address each signature line.

Staff Who Require a Co-Signature:

1. Sequence 1 (Staff Requiring Co-Signature) - Left click and select “Electronically
Sign.”

Validations - i

Seve... |Validah’0n - Description |

Critical Pending Staff Signature ... Must be electronically signed by at least one Staff
Member to be Final Approwved.

Staff Signature Required  Seguence 1: Staff Requiring Co-g

| Critical ~ Staff Signature Required  Sequence 2: Staff Comp/Accepty
| Critical ~ Staff Signature Required  Sequence 3: Staff Entering Infnl Electronically Sign I

Ascign Signatory

Assign Signatory and Sign

Document Signature on Hard Copy

Clear Signature

Delete
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Assessments

2. Enter your CCBH password when prompted.

Cch! Password - STAFF TRAINEE x

F'assword| xxxxxxxxxxxxx 1 || Ok |

3. Sequence 2 (Staff Comp/Accept Assessment) — Left click and select “Assign
Signatory.”

Validations - 4
Seve... |Vlidation & | Deserpion "
Critical  Staff Sgnawre Required  Sequence 2: Staff C e 5
Crilical  SlalT Siynawe Reguired  Seguence 3: SlalT Enlering - [

Electrecnically Sian

Asgign Signatory

Azgign Signatory and Sign
Dacument Signature on Hard Copy

Clear Signature

Delete

4. Find your supervisor by name or staff ID. Highlight their name and choose
“Select” at the top.

Lookup Panel

T
R g
Select Close

Panel
Actions Close

ﬂ Select a Staff Member from the list.

Staff List
[1D] Full M arne

800015 PARAPRO, STAFF
200013 STAFF, TFC
800023 STAFF, PM
910001 RM1 DHP

AFF CLIMICAL
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Assessments

5. Sequence 3 (Staff Entering Information), if applicable — Left click and select “Delete.”
Validations -~ B

Seve... |Validaﬁ0n - |Descriph'0n
Critical  Staff Signature Required  Sequence 2: Staff Comp/Accept Assessment - CLIML...

Critical Staff Signature Regquired Seguence 3: Staff,
»

Electronically Sign

Assign Signatory
Assign Signatory and Sign
Document Signature on Hard Copy

Clear Signature

Delete

6. Click “Save and Close” located at the top of the window. After you click “Save
and Close,” you return to the Clinician’s Homepage. The name of the client will
display on the Notifications list on your Clinician’s Homepage and on the
Homepage of the approved signer until the assessment is co-signed and final

approved.

File Assessment

S HHbe X & & 2 3

—_5 | s f -

Refresh Perfarm Save and | Save Final Print Delete Add Prospective Progress Close
Validation Check Close Approve Signature = | Planning Tiers Indicatars~  Panel

Refresh Validation Actions Delete | Signatures Clinical Close

Staff Who Final Approve (or Co-Sign) Assessments For Others:

1. Find the client on your Naotifications list on the Clinician’s Homepage.

2. Access the assessment and review. The person for whom you are co-signing
should have already completed Sequence 1 signature line and deleted Sequence

3.

3. Sequence 2 (Staff Comp/Accept Assessment) — Left click and select
“Electronically Sign.”

Validations - I

SEVE... |'l.-'ali|:|aﬁ|:|n rs |Desn:ri|:|ﬁ|:|n |

Cﬁﬁml Staff Signature Required  Seguence 2: Staff Comp/Accept Asses

Electronically Sign
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Assessments

4. Enter your CCBH password when prompted.

Ch! password - CLINICAL STAFF

F'asswu:urd| xxxxxxxxxxxx ,1 Ok

5. Click “Final Approve” located at the top of the window.
_ Pending Diagnosis Form for
Assessment

2 ® HHble X & | & 2 =

Refresh Perform Save and Save Final Print Delete Add Prospective Progress Close
Validation Check Close Approve Signature * | Planning Tiers Indicators ~ Panel
Refresh Validation Actions Delete | Signatures Clinical Close

REMINDER: Co-signatures and final approval of assessments should be done as soon
as possible.

PLEASE REMEMBER:

®' Passwords may NEVER be shared as this constitutes a

breach of security and HIPAA violation.

NOTES
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VIEWING ASSESSMENTS Assessments

Saved forms:
e Are “saved” but not final approved.
e Can be edited or deleted by anyone who has access to that client’s forms.
e  Will hold up the work flow as they prevent adding another form in which any fields
are shared.

Lock it down by Final Approving to protect your work!!

How to open a saved assessment:

e Select a client and open the “Client Panel”’. Next, click the “Assessments” pane.

e Alist of assessments will display. The assessment that is not final approved will
not have a check under the Final Approved status (F/A).

e Double click the assessment. The selected assessment will open for data
entry and completion.

=

“ FAKE TEST At
Assessments - q
|Date = | Description ﬁ*\“ﬂ v |

| 07/01/2015 Demographics Form =
| |
| 07012015 Diagnosis Form

s’

Face Sheet  Pre-Intake |'Assessments | Primary Assig... 4 Prmary Di... Primary Subs...  CurrentClien... ProgressNotes Authorizatons Primary Insur...  Services  Medical Cond...  Medications

VIEWING FINAL APPROVED ASSESSMENTS

e Select a client and open the “Client Panel”.
e Next, click the “Assessments” pane.
o Alist of assessments will display. The assessments that are final approved

will have a check under the Final approved status (F/A).
e Double click the assessment. The selected assessment will open for review.

-
“ FAKE TEST =Rl
Assessments ~ 1
|Date & |Descnpt|on a LK | v | ‘;
| W15 ] |
| 07/23/2015 Diagrosis Form L]
07232015 Dizgrosis Form
| 08/21/2015 Diagrosis Form =] =
Face Sheet  Pre-Intske | Assessments | Primary Assig... fw: Primary Di...  Primary Subs.,.  CurrentClien... ProgressNotes Authorizatons Primary Insur... Services Medical Cond .. Medications
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Assessments

PRINT TO SCREEN

Note: Before printing a hard copy, always print to screen first to verify whether
printing is truly necessary.

e Click the “Print” button.

| Assessment
@. W] Wl = '2
N e == P & &
Refresh Perform Save and Save Final Add Prospective Progress
Validation Check Close Approve Signature = Planning Tiers Indicators =
Refresh Validation Actions Signatures Clinical

e Click on the down arrow to the right of the “Printer” field, click “Print Preview”,
and click the “Print” button.

Refresh Print Close

Panel
Actions Close

[l Select options related to the printing of the Client's Assessment

Printer
F'rinter| Drefault Printer (v
Diagnosl " Fint Preview _

Processing

Gensrating It will take a few moments to process the command. Wait
until the following message disappears.

A copy displays on the screen. Pay attention to the total number of pages before
deciding to print a physical copy.
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Assessments
A copy displays on the screen. Pay attention to the total number of pages before

deciding to print a physical copy.

[
| Hame: LAST, FIRET MIDDLE Cazed: Pige: 1072 ff— |
| Type: [rate:
Pl A b UM AT 3 T
n
Icons

You will find icons across the top of the print screen which will allow navigation through
the copy.

SE TR KWdbPN 79 ®
Prints a physical copy.
=1 Emails a copy. DO NOT use this feature, as it is abreach in confidentiality.

141 Displays the default size of the copy.

Shrinks the copy down to 25% of the default size.
N Zooms in by 50% each time the icon is clicked.

= Zooms out by 25% each time the icon is clicked.
K Navigates directly to the first page.

4 Navigates back one page.

p Navigates forward one page.

M Navigates directly to the last page.

7 Displays keyboard commands for navigating through the copy.
¥ Displays the details of the software product.

e Closes out of "Print to Screen” and returns to the original view.
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Assessments

Support Desk Contact Information

sdhelpdesk@optum.com
1-800-834-3792

Monday through Friday (E-mail)

Hours Services
6:00 am to 6:00 pm All services except password resets or any service involving PHI
Monday through Friday (Telephone)
Hours Services

4:30 am to 6:00 am Resetting passwords (24 hour programs) and reporting system outages*
6:00 am to 6:00 pm All services

6:00 pm to 11:00 pm | Resetting passwords (24 hour programs) and reporting system outages*
11:00 pm to 4:30 am | Reporting system outages*

\Weekends (Telephone
Hours Services

4:30 am to 11:00 pm | Resetting passwords (24 hour programs) and reporting system outages*
11:00 pm to 4:30 am | Reporting system outages*

* By definition, a system outage affects multiple users. Examples includewhen:
-The system does not respond and appears to be frozen
-No data can be entered or viewed

Support Desk Suggestions

e Please consult with your program manager and your resource packet prior to
contacting the Support Desk.

e When calling for a password reset on weekdays between 4:30-6a or 6-11p, or
calling weekends between 4:30a-11p, you must leave a message. Include your
name, CCBH staff ID, phone number and the reason for your call.

e You may be given a ticket/tracking number if you call between 6:00a and 6:00p
Monday through Friday. Remember to keep this number for future reference.

Additional Contacts

Questions Where To Go
Clinical Documentation Questions Documentation Manual/Your Program Manager
Duplicate Clients and Complete Form BHS-025 and
Name/DOB/Gender/SSN Changes Call Medical Records: 619-692-5700 x 3
Financial Questions (UMDAP/Insurance) Billing Unit: 619-338-2612 Fax- 858-467-9682
Online User Manuals and Forms www.optumsandiego.com
Service Codes CCBH (Anasazi) User Manual/QM Unit
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